1 Welcome to Enpass Portable
   1.1 Prerequisites .................................................. 2
   1.2 Who should use Enpass Portable? ............................. 2
2 Whats New in 5.5.5
   Attachment Support .................................................. 3
   Quick PIN support .................................................. 3
   CSV/DSV Import ...................................................... 3
   zxcvbn will show the strength of your passwords .............. 3
   Selective field sharing ........................................... 3
   Subset of password ................................................ 3
   A better way to organize items .................................. 3
3 Setting up Enpass Portable
   3.1 For Mac & Windows ............................................. 5
   3.2 For Linux ......................................................... 5
   3.3 For Cross-platform Usage .................................... 6
4 Using Enpass Portable
   4.1 Enpass Browser Extension .................................... 10
5 Importing data from other softwares
   5.1 List of supported softwares .................................. 11
   5.2 Steps to import .................................................. 12
      5.2.1 From 1Password .............................................. 12
          Step 1: Export data from 1password ......................... 12
          Step 2: Import data into Enpass desktop ................. 12
      5.2.2 From Lastpass ............................................... 13
          Step 1: Export data from Lastpass ......................... 13
          Step 2: Import data into Enpass desktop ................. 13
      5.2.3 From Dashlane ............................................... 14
          Step 1: Export data from Dashlane ....................... 14
          Step 2: Import data into Enpass desktop ............... 14
      5.2.4 From Sticky Password .................................... 14
          Step 1: Export data from Sticky Password .............. 15
          Step 2: Import data into Enpass desktop ............... 15
      5.2.5 From other password managers .......................... 15
          Step 1: Export data from that password manager ....... 15
          Step 2: Import that data into Enpass desktop ......... 16
   5.3 Help Video ........................................................ 19
Welcome to the user manual for Enpass Portable. This manual features detailed guidelines to make you well-acquainted with the app’s functionality.
The Enpass portable version is all similar to the Enpass Desktop version, except you don’t need to install it on the system you want to use. It provides the assistance to carry all your passwords in the USB drive along with credit cards, bank accounts, ID cards and other life important credentials, with you anywhere in the world.

1.1 Prerequisites

To use the Portable version, all you need is a USB drive and the platform specific Enpass Portable zip file.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Compatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Windows 7 or later</td>
</tr>
<tr>
<td>Mac</td>
<td>OSX 10.8 or later</td>
</tr>
<tr>
<td>Linux</td>
<td>Tested on Ubuntu 14.04 or later ; Fedora 22 or later (only for 64-bit OS)</td>
</tr>
</tbody>
</table>

1.2 Who should use Enpass Portable?

If you want to use Enpass on your personal desktops, then you should always use our desktop app. But if you can relate yourself with any of the following conditions, Enpass Portable is for you.

- You are a System administrator and have to keep switching workstations.
- You are not able to install Enpass desktop app and need admin rights.
- You travel a lot and need to access your data on some other PC where you can’t install the desktop version. Though we don’t recommend to plug in your USB in any insecured/unknown system.
- You have to work with multiple Enpass databases.
WHATS NEW IN 5.5.5

Attachment Support

From now on, you can attach files to Enpass, be it the snap of your Passport, your credit card or any other kind of file you want to keep confidential in Enpass vault.

Quick PIN support

You can now set an alphanumeric PIN to quickly unlock Enpass if the App is already running in the background, otherwise, master password will be required.

CSV/DSV Import

If you’re having your passwords and login details in CSV or any other delimiter separated file, you can now import them in Enpass using the all new custom CSV/DSV data importer.

zxcvbn will show the strength of your passwords

We have empowered the password strength indicator with Dropbox zxcvbn to check you from choosing weak passwords.

Selective field sharing

Sharing has gone better with an option to choose the fields to be shared rather than the whole item. So now you can share your bank details with anyone by removing login and other sensitive details. Cool, huh!

Subset of password

It lets you see certain characters in password specified by position, for example, “1st, 3rd, next-to-last, last” by just mentioning their position in a specified format.

A better way to organize items

You can now create sub-folders by right clicking on parent folder in sidebar with an additional feature to move sub-folders among parent folders by ‘drag n drop’. We have also improved the drag ‘n’ drop behavior for moving items...
between categories and folders where now you also get the option of copying them (instead of moving only) by pressing and holding the ‘option’ key.

**See also:**

For complete list of other changes, please check [Release notes](#).
CHAPTER THREE

SETTING UP ENPASS PORTABLE

Setting up Enpass Portable is more easy than it sounds and doesn’t need any special instructions.

3.1 For Mac & Windows

- Download and extract the EnpassPortable, and copy the extracted folder to FAT32 formatted USB drive.
- All done. You can run the platform specific executable file now.

Note: You can also create a cross-platform USB drive for all the desktop platforms. Read here.

3.2 For Linux

- Download and extract the EnpassPortable.tar.gz (currently available for 64-bit OS only), and copy the extracted folder to EXT4 formatted USB drive.
- All done. Open the folder and run the executable file.
Important: We recommend you to manually take backup of your latest data on your desktop or enable sync to your cloud. Because in case of loss or theft of your USB drive, there would be no other way to recover the data.

3.3 For Cross-platform Usage

The best thing about Enpass portable is that you can use the Enpass on single USB for all the supported platforms. All you need to do is to follow these simple steps to set your sails-

- Create a shared partition in EXT4 and FAT32 format in the same USB drive. Each partition must be of minimum 200 mb in size.
- Copy the Windows and Mac supported Enpass portable file in the FAT32 formatted partition, and Linux file in the EXT4 formatted partition.
- You’re all done here. Simply run the platform specific executable file in the USB drive.
The best thing about Enpass Portable is you don’t need to install it, just copy the files in your USB drive, plug-in and go!

- Run the Enpass Portable file saved in your USB drive. A pop-up will appear asking to choose the location to save/open your Enpass database.

Note: For quick access, you can also save the location of your database for future reference by clicking the Remember location check-box.

- Click on Browse and set the location for your database.
• In case you have already saved the location, you will also get an option to choose the database from your recent saved locations.

• Once you’ve set the location for your Enpass data, you would be provided with a screen where you can set up the Enpass according to your preferences.
• Next time when you’ll log into Enpass, it will automatically load previous data (if the location is still accessible) and prompt you to enter the master-password. Though, the location can be changed by clicking the Choose another button.

Enpass Portable works the same way as the desktop App version 5.5.2. For further assistance, you may go through the following links:

• Enpass user manual for Mac.
• Enpass user manual for Windows.
• Enpass user manual for Linux.
4.1 Enpass Browser Extension

Like the Enpass desktop app, the portable version also gives you the assistance to auto-fill the logins using the Enpass browser extensions for Safari, Chrome, Firefox, Vivaldi and Opera.
IMPORTING DATA FROM OTHER SOFTWARES

If you are using any other password manager and want to switch to Enpass, the Free Desktop Version of Enpass lets you import data from other password managers with just one click.

5.1 List of supported softwares

We have tested importing data into Enpass from 26 other password managers. The following table lists them along with their respective unencrypted file types from which Enpass can import data.

<table>
<thead>
<tr>
<th>Software name</th>
<th>Tested version</th>
<th>Unencrypted file format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Password-Agile Keychain (Windows)</td>
<td>4.6.0</td>
<td>1password interchange file (.1pif)</td>
</tr>
<tr>
<td>1Password-Agile Keychain (MAC)</td>
<td>6.0</td>
<td>1password interchange file (.1pif)</td>
</tr>
<tr>
<td>aWallet</td>
<td>6.0.2</td>
<td>CSV file (.csv)</td>
</tr>
<tr>
<td>B-Folders</td>
<td>4.7.1</td>
<td>CSV file (.csv)</td>
</tr>
<tr>
<td>Dashlane</td>
<td>3.5.0</td>
<td>dashlane csv (.csv)</td>
</tr>
<tr>
<td>DataVault (Windows)</td>
<td>2.1.14</td>
<td>CSV file (.csv)</td>
</tr>
<tr>
<td>DataVault (MAC)</td>
<td>5.2.39</td>
<td>CSV file (.csv)</td>
</tr>
<tr>
<td>eWallet (Windows)</td>
<td>2.1.14</td>
<td>Text file (.txt)</td>
</tr>
<tr>
<td>eWallet (MAC)</td>
<td>7.4.4</td>
<td>Text file (.txt)</td>
</tr>
<tr>
<td>Handy Safe (Windows)</td>
<td>3.01</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>Handy Safe (MAC)</td>
<td>1.02</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>Keepass (Windows)</td>
<td>1.29</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>Keepass (MAC)</td>
<td>2.28</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>KeepassX</td>
<td>0.4.3</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>Keeper (Windows)</td>
<td>8.3.1</td>
<td>Text file (.txt)</td>
</tr>
<tr>
<td>Keeper (MAC)</td>
<td>2.15</td>
<td>Text file (.txt)</td>
</tr>
<tr>
<td>LastPass (Windows)</td>
<td>4.0.0</td>
<td>Text file (.txt)</td>
</tr>
<tr>
<td>LastPass (Windows)</td>
<td>4.0.0</td>
<td>CSV file (.csv)</td>
</tr>
<tr>
<td>LastPass (MAC)</td>
<td>4.0.0</td>
<td>Text file (.txt)</td>
</tr>
<tr>
<td>mSecure</td>
<td>3.5.4</td>
<td>CSV file (.csv)</td>
</tr>
<tr>
<td>Moxier Wallet</td>
<td>1.1.3</td>
<td>CSV file (.csv)</td>
</tr>
<tr>
<td>oneSafe (Windows)</td>
<td>3.0.1</td>
<td>CSV file (.csv)</td>
</tr>
<tr>
<td>oneSafe (MAC)</td>
<td>1.5.1</td>
<td>CSV file (.csv)</td>
</tr>
<tr>
<td>Blackberry Password Keeper</td>
<td>10.3.0.54</td>
<td>CSV file (.csv)</td>
</tr>
<tr>
<td>Password Depot</td>
<td>9.0</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>Password Gorilla</td>
<td>1.5.3.6</td>
<td>CSV file (.csv)</td>
</tr>
<tr>
<td>Password Padlock</td>
<td>7.4</td>
<td>Text file (.txt)</td>
</tr>
</tbody>
</table>

Continued on next page
Table 5.1 – continued from previous page

<table>
<thead>
<tr>
<th>Software name</th>
<th>Tested version</th>
<th>Unencrypted file format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Safe (Windows)</td>
<td>3.35</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>Password Safe (MAC)</td>
<td>3.1</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>Pocket</td>
<td>2.7</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>RoboForm (Windows)</td>
<td>7.9.16</td>
<td>HTML file (.html)</td>
</tr>
<tr>
<td>RoboForm (Windows)</td>
<td>7.9.16</td>
<td>HTM file (.htm)</td>
</tr>
<tr>
<td>RoboForm (MAC)</td>
<td>2.0.1</td>
<td>HTML file (.html)</td>
</tr>
<tr>
<td>SafeInCloud</td>
<td>2.4</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>Safe Wallet (windows)</td>
<td>2.4.2.7</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>Safe Wallet (MAC)</td>
<td>1.2</td>
<td>XML file (.xml)</td>
</tr>
<tr>
<td>SPB Wallet (Windows)</td>
<td>2.2</td>
<td>Text file (.txt)</td>
</tr>
<tr>
<td>SPB Wallet (MAC)</td>
<td>2.1</td>
<td>Text file (.txt)</td>
</tr>
<tr>
<td>Splash ID</td>
<td>8.0.6</td>
<td>VID file (.vid)</td>
</tr>
<tr>
<td>Sticky Password</td>
<td>8.0.6</td>
<td>Text file (.txt)</td>
</tr>
</tbody>
</table>

5.2 Steps to import

Following steps would guide you to import the data from other password managers to Enpass.

5.2.1 From 1Password

This section is for you if you are using 1Password and want to switch to Enpass. If it is so, we thank you for liking Enpass.

Step 1: Export data from 1password

Before importing your data from 1Password to Enpass, first you need to export your 1Password data in the .1pif unencrypted file format. Usually you need the desktop version for respective software to export your data in unencrypted format.

Follow these steps to export your data-

- Open 1Password App.
- Click on File → Export → All items.
- Select 1pif file format.
- Choose a name for the .1pif file and save it to your desktop.

Warning: The data exported to unencrypted file is highly insecure and vulnerable. We recommend that you delete the corresponding .1pif file as soon as the importing process is finished.

Step 2: Import data into Enpass desktop

Only the desktop version of Enpass can import data from 1Password. The process is automatic and very easy.

- Start the Import wizard from File-Import.
- The first step of Import wizard is to select the 1Password from the list and click Continue.
- Locate the .1pif file containing the exported data. Click Continue.
• The next screen will show all the items detected in the selected file and ready to be imported in Enpass. Have a quick look to check if they are recognized properly. Click **Import**.

• Importing process will start and will take some time depending upon the number of items being imported.

• The next screen will show **Success** message with number of items successfully imported in Enpass. Click **Done**.

**Warning:** Now you must delete the corresponding .1pif file as it is unprotected and highly insecure to keep.

• The main screen of Enpass will be displayed with all the recently imported items placed under **Import** category.

• You are now free to edit them or to change their category by simply dragging and dropping to that particular category.

### 5.2.2 From Lastpass

This section is for you if you are using Lastpass and want to switch to Enpass. If it is so, we thank you for liking Enpass.

**Step 1: Export data from Lastpass**

Before importing your data from Lastpass to Enpass, first you need to export your Lastpass data in the .csv unencrypted file format. Usually you need the desktop version for respective software to export your data in unencrypted format. Follow these steps to export your data-

• Click the LastPass extension button in the browser.

• Choose More Options > Advanced > Export.

• Select LastPass .csv or .txt File.

• If prompted, enter your LastPass Master Password.

• Choose a name for the file and save it to your desktop.

**Warning:** The data exported to unencrypted file is highly insecure and vulnerable. We recommend that you delete the corresponding .csv or .txt file as soon as the importing process is finished.

**Step 2: Import data into Enpass desktop**

Only the desktop version of Enpass can import data from Lastpass. The process is automatic and very easy.

• Start the **Import wizard** from File-Import.

• The first step of **Import wizard** is to select the Lastpass from the list and click **Continue**.

• Locate the .csv or the .txt file containing the exported data. Click **Continue**.

• The next screen will show all the items detected in the selected file and ready to be imported in Enpass. Have a quick look to check if they are recognized properly. Click **Import**.

• Importing process will start and will take some time depending upon the number of items being imported.

• The next screen will show **Success** message with number of items successfully imported in Enpass. Click **Done**.

**Warning:** Now you must delete the corresponding .csv file as it is unprotected and highly insecure to keep.

• The main screen of Enpass will be displayed with all the recently imported items placed under **Import** category.
• You are now free to edit them or to change their category by simply dragging and dropping to that particular category.

5.2.3 From Dashlane

This section is for you if you are using Dashlane and want to switch to Enpass. If it is so, we thank you for liking Enpass.

Step 1: Export data from Dashlane

Before importing your data from Dashlane to Enpass, first you need to export your Dashlane data in the .csv unencrypted file format. Usually you need the desktop version for respective software to export your data in unencrypted format.

Follow these steps to export your data-

• Open Dashlane app.
• Click on File → Export → All items.
• Select csv file format.
• Choose a name for the csv file and save it to your desktop.

**Warning:** The data exported to unencrypted file is highly insecure and vulnerable. We recommend that you delete the corresponding .csv file as soon as the importing process is finished.

Step 2: Import data into Enpass desktop

Only the desktop version of Enpass can import data from Dashlane. The process is automatic and very easy.

• Start the **Import wizard** from File-Import.
• The first step of **Import wizard** is to select the Dashlane from the list and click **Continue**.
• Locate the .csv file containing the exported data. Click **Continue**.
• The next screen will show all the items detected in the selected file and ready to be imported in Enpass. Have a quick look to check if they are recognized properly. Click **Import**.
• Importing process will start and will take some time depending upon the number of items being imported.
• The next screen will show **Success** message with number of items successfully imported in Enpass. Click **Done**.

**Warning:** Now you must delete the corresponding .csv file as it is unprotected and highly insecure to keep.

• The main screen of Enpass will be displayed with all the recently imported items placed under **Import** category.
• You are now free to edit them or to change their category by simply dragging and dropping to that particular category.

5.2.4 From Sticky Password

This section is for you if you are using Sticky Password and want to switch to Enpass. If it is so, we thank you for liking Enpass.
**Step 1: Export data from Sticky Password**

Before importing your data from Sticky Password to Enpass, first you need to export your Sticky Password’s data in the .txt unencrypted file format. Usually you need the desktop version for respective software to export your data in unencrypted format.

**Note:** You must change the App’s language to English for the convenience in importing the data.

Follow these steps to export your data-

- Open Sticky Password App.
- Click on Menu → Export → All items.
- Select .txt file format.
- Choose a name for the .txt file and save it to your desktop.

**Warning:** The data exported to unencrypted file is highly insecure and vulnerable. We recommend that you delete the corresponding .txt file as soon as the importing process is finished.

**Step 2: Import data into Enpass desktop**

Only the desktop version of Enpass can import data from Sticky Password. The process is automatic and very easy.

- Start the *Import wizard* from File-Import.
- The first step of *Import wizard* is to select the Sticky Password from the list and click *Continue*.
- Locate the .txt file containing the exported data. Click *Continue*.
- The next screen will show all the items detected in the selected file and ready to be imported in Enpass. Have a quick look to check if they are recognized properly. Click *Import*.
- Importing process will start and will take some time depending upon the number of items being imported.
- The next screen will show *Success* message with number of items successfully imported in Enpass. Click *Done*.

**Warning:** Now you must delete the corresponding .txt file as it is unprotected and highly insecure to keep.

- The main screen of Enpass will be displayed with all the recently imported items placed under *Import* category.
- You are now free to edit them or to change their category by simply dragging and dropping to that particular category.

**5.2.5 From other password managers**

This section is for you if you are using any other password manager and want to switch to Enpass. If it is so, we thank you for liking Enpass.

**Step 1: Export data from that password manager**

Before importing your data into Enpass from the password manager you are using, the first step is to export your data from that password manager in the unencrypted file format as mentioned in the list of supported software. Usually you need the desktop version for respective software to export your data in unencrypted format.

For any help regarding exporting your data in supported file format, please contact the respective vendor.
Warning: The data exported to unencrypted file is highly insecure and vulnerable. We recommend that you delete the corresponding .TXT, .CSV, .XML or other unprotected file as soon as the importing process is finished.

Step 2: Import that data into Enpass desktop

Only the desktop version of Enpass can import data from other software. The process is automatic and very easy.

- Start the Import wizard from File-Import.

- The first step of Import wizard is to select the password manager you are already using and have exported the data from as in Step 1. Click Continue.
• Locate the file containing exported data for the selected software. Click **Continue**.

• The next screen will show all the items detected in the selected file and ready to be imported in Enpass. Have a quick look to check if they are recognized properly. Click **Import**.
• Importing process will start and will take some time depending upon the number of items being imported.

• The next screen will show **Success** message with number of items successfully imported in Enpass. Click **Done**.

**Warning:** NOW you must delete the corresponding .TXT, .CSV, .XML or other unprotected file as they are unprotected and highly insecure to keep.

• The main screen of Enpass will be displayed with all the recently imported items placed under **Import** category.
• You are now free to edit them or to change their category by simply dragging and dropping to that particular category.

5.3 Help Video

For more help, watch help video demonstrating steps to import data screen by screen.